University of South Carolina

Electronic Thesis and Dissertation Formatting Guide

http://gradschool.sc.edu/students/thesisdiss.asp

Last Revised: July, 2017
# University of South Carolina | Electronic Thesis and Dissertation Formatting Guide

I. Introduction ......................................................................................................................... 4

II. General Formatting ........................................................................................................... 5

A. Margins ............................................................................................................................... 5

B. Page Numbering ............................................................................................................... 5

C. Line Spacing ...................................................................................................................... 5

D. Fonts ................................................................................................................................. 5

E. Paragraphs ......................................................................................................................... 6

F. Headings and Subheadings .............................................................................................. 6

G. Widows and Orphans ....................................................................................................... 6

H. Tables ............................................................................................................................... 6

I. Figures ............................................................................................................................... 7

J. Endnotes and Footnotes ................................................................................................... 7

K. Landscape-Oriented Pages ............................................................................................... 8

III. Document Organization .................................................................................................. 8

A. Title Page ........................................................................................................................... 9

B. Copyright Page ................................................................................................................ 10

C. Dedication ........................................................................................................................ 11

D. Acknowledgements ......................................................................................................... 11

E. Abstract ............................................................................................................................. 11

F. Preface .............................................................................................................................. 11

G. Table of Contents .......................................................................................................... 12

H. List of Tables .................................................................................................................... 13

I. List of Figures .................................................................................................................... 13

J. List of Symbols ................................................................................................................. 13
K. List of Abbreviations ............................................................................................................13
L. Foreword or Introduction .....................................................................................................14
M. Chapters ..............................................................................................................................14
N. Bibliography or Works Cited or References pages .........................................................14
O. Appendix or Appendices ....................................................................................................15

IV. Journal Articles as Chapters, or Manuscript Style ..........................................................15
   A. Authorship .......................................................................................................................15
   B. Copyright Release .........................................................................................................16
   C. Overall Document Structure .......................................................................................16
   D. Tables and Figures .........................................................................................................16
   E. Chapter Cover Page .......................................................................................................16

V. Useful Tips ..........................................................................................................................18
   A. Templates .......................................................................................................................18
   B. Samples ..........................................................................................................................18
   C. Formatting Margins ........................................................................................................19
   D. Page Breaks and Section Breaks ..................................................................................20
   E. Formatting Leaders ......................................................................................................23
   F. Landscape Orientation ..................................................................................................24
   G. Embedding Fonts ..........................................................................................................28
   H. Assembling Your Final PDF .........................................................................................28

VI. Submission ........................................................................................................................28
   A. How to Submit your Thesis/Dissertation to the Graduate School ...............................28
   B. Deadlines ......................................................................................................................29
I. Introduction

Welcome to the University of South Carolina Electronic Thesis and Dissertation Formatting Guide. This guide sets forth the specific format requirements mandated by the Graduate School for all theses and dissertations. In order to best preserve and share your work with other scholars, the Graduate School requires consistency of form and appearance for all documents. This guide is designed to assist you in preparing a thesis or dissertation that conforms to the Graduate School’s requirements.

This guide is not intended to address every conceivable style or formatting issue you may encounter when preparing your thesis/dissertation. You should refer to the style manual approved by your department for answers to questions not resolved here. The Chicago Manual of Style is preferred by the Graduate School, though others are acceptable. However, where there is a conflict between a given style manual and this guide, the Graduate School’s requirements take precedence, and should be followed.

In addition, you should not rely on a former student’s accepted thesis or dissertation as a template for your document – use only the current version of this guide, and the samples provided by the Graduate School. Format requirements change, and a document that was acceptable in the past may not adhere to the current guidelines. It is your responsibility as the student to ensure that the document you submit meets the requirements described in this guide.

The Graduate School does not accept theses or dissertations in a physical format – that is to say, you will not turn in a paper copy of your document. Through an arrangement with ProQuest/United Microforms International, all theses and dissertations are accepted in electronic format. You will submit an electronic version of your final document directly to ProQuest/UMI, via the UMI ETD website (http://www.etdadmin.com/cgi-bin/main/home?siteId=145). The Graduate School staff will then review your submission for conformance with the format requirements, and request revisions, if any are necessary. For further explanation of the submission process, see page 28 of this guide.

One of the primary considerations that you should keep in mind as you prepare your thesis or dissertation is consistency. Where there are specific directives set out in this guide regarding a particular topic, you do not have the option to ignore those instructions. However, there will be situations in which you will have a certain amount of flexibility. Where you have options, it is important that you make a choice and apply it consistently throughout your document. Consistency of format is essential because it visually guides readers through your document, allowing them to focus on content. Varying your formatting choices will only serve as a distraction.
II. General Formatting

A. Margins

Every page of your thesis/dissertation must be printable on standard 8.5” x 11” paper. Do not include borders on your document. Your final document must have the following uniform margins:

1. Left and right margins must be set at 1.25” on every page, including pages containing footnotes, appendices, charts, graphs, tables, figures, etc.
2. Top margins must be 2” for all pages with a major heading (see the list of major headings, below) and for the first page of each chapter. All other pages must have 1” top margins.
3. Bottom margins must be set at 1” throughout.

All content on every page must fit within these margins, including tables, figures, footnotes, etc. For help formatting margins, see the “Useful Tips” section at the end of this Guide.

B. Page Numbering

Page numbers must be centered .5” from the bottom of the page (i.e., in the “footer” of the page). There will be two pagination sequences in your document: a lowercase Roman numeral sequence and an Arabic numeral sequence. Adhere to these requirements when numbering your pages:

1. Use lowercase Roman numerals (i, ii, iii, iv, etc.) to number your front matter pages (acknowledgements, dedication, table of contents, etc.). The title page should not display a number, but should be included in the sequence.
2. Beginning with the foreword or introduction (if present) or the first page of the first chapter (if you do not have a foreword/introduction), use Arabic numerals (1, 2, 3, 4, etc.) to number the remaining pages of the text, including the bibliography and any appendices. This sequence should begin at “1”; do not continue the sequence from your front matter. You should not start a new numbering sequence for each chapter/section, but should continue the same sequence for the remainder of the thesis/dissertation.
3. Page numbers on landscape-oriented pages must be in the same location as numbers on portrait-oriented pages. See the “Useful Tips” section at the end of this guide for help formatting landscape pages.
4. Use the same font for the page numbers that you have used for the rest of your text.

C. Line Spacing

Paragraphs in the front matter sections and in the chapters of your document must be double-spaced. Refer to your style manual when determining how to space things like block quotations, bibliographic entries, endnotes and footnotes, etc.

D. Fonts

Any of the following standard 12-point fonts are acceptable: Arial, Calibri, Courier New, Palatino, Tahoma, Times New Roman. You must choose one of these fonts and use only this font throughout the entirety of the document (including for page numbers, footnotes, endnotes,
figures, tables, etc.); do not switch back and forth between different fonts. Do not use running headers or footers, and please use boldface sparingly. Do not use any font color besides black (use of color in illustrations, figures, graphs, etc. is permitted, but not for text). ProQuest/UMI requires that all fonts used in your document must be embedded in the final PDF you submit. For help embedding fonts, see the “Useful Tips” section at the end of this Guide (page 27).

E. Paragraphs

The first line of a new paragraph should be distinguished by indentation, though this feature is optional in the first paragraph of a chapter or section. Either left-justification or full-justification is acceptable for the text of the document – you should choose one method and apply it consistently. There are to be no skipped lines or extra spaces between paragraphs; the text should run continuously from paragraph to paragraph without large blank spaces on the pages.

F. Headings and Subheadings

The Graduate School does not set any specific standards for the format of chapter headings and subheadings, except for font size, which must be 12-14 point. Students should refer to the standards set by their department’s choice of style manual. Regardless of which style you use, all heading and subheading formatting must be consistent throughout your document. For example, if you decide to center some major headings in size 14 bold font, then all of the major headings should be centered, size 14, and bold. The major headings in the document are: Dedication, Acknowledgements, Abstract, Preface, Table of Contents, List of Tables, List of Figures, List of Symbols, List of Abbreviations, Foreword/Introduction, the first heading in every chapter (such as Chapter 1 or Chapter I), the heading at the top of the references section, and the first heading in every appendix.

G. Widows and Orphans

The first or last line of a paragraph, a heading, or a subheading must not be isolated by a page break. Such isolated lines are called “widows” and “orphans,” and most word processors can be set to prevent them.

H. Tables

You may choose one of three options when inserting tables or figures into your document:

1. Embed the table or figure in the text. Do not use text-wrapping around the sides of the item – text should only appear above and/or below the item.

2. Place the table or figure on a separate page immediately following the page where it is first cited. Do not leave any extra space at the bottom of the preceding page – the text should run continuously.
3. Insert all tables and figures at the end of their respective chapters. All of the tables should be placed on consecutive pages, followed by the figures. Place the items in the same order they are referenced in the text.

- Every table must have a descriptive title. Titles of tables should appear at the top of the table, with the bottom line of the title 2 lines above the top of the table – there should be 1 blank line between the title and the top of the table. A table title may not consist of more than one sentence or phrase.
- If the title is more than one line, single-space the entry.
- Titles should begin with the word “Table” followed by the number of the chapter, a period, and the number of the table. Table numbering should restart for each chapter (e.g. 3.1 . . . 3.5, 4.1 . . . 4.9, etc.). If a table occurs in an appendix to the document, the table number should include the letter assigned to the appendix (e.g. A.1 . . . A.5, B.1 . . . B.9, etc.). In this way, each table will have a unique number designation.
- Titles should be flush with the left side of the table and not extend beyond the width of the table.
- Do not include typesetting notations in your document (such as “Insert Table 1.4 here”).
- Tables must fit within the prescribed margins set out previously in this guide.

I. Figures

See the previous section for your options regarding placing a figure into your document.

- Captions should appear at the bottom of the figure, with the first line of the caption 2 lines below the bottom of the image – there should be 1 blank line between the bottom of the figure and the caption.
- If the caption is more than one line, single-space the entry.
- Captions should begin with the word “Figure” followed by the number of the chapter, a period, and the number of the figure. Figure numbering should restart for each chapter (e.g. 3.1 . . . 3.5, 4.1 . . . 4.9, etc.). If a figure occurs in an appendix to the document, the figure number should include the letter assigned to the appendix (e.g. A.1 . . . A.5, B.1 . . . B.9, etc.). In this way, each figure will have a unique number designation.
- Captions should be flush with the left side of the figure and not extend beyond the width of the figure.
- Do not include typesetting notations in your document (such as “Insert Figure 1.4 here”).
- Figures must fit within the prescribed margins set out previously in this guide.

J. Endnotes and Footnotes

You may use either endnotes or footnotes throughout your document, but not both. If you decide to use endnotes or footnotes, you should use your word processing software’s automatic function for doing so – do not insert endnotes or footnotes manually. Please refer to a style manual appropriate to your department or discipline for answers to specific style questions not addressed here, such as whether to single-space or double-space endnotes and footnotes.
Endnotes are placed at the end of the chapter or the end of the document, and are to be consecutively numbered throughout the document. Footnotes are placed at the bottom or foot of the same page where the reference is made; footnote numbering may be consecutive throughout the document, or restarted with each chapter.

**K. Landscape-Oriented Pages**

Landscape-oriented pages are limited to pages containing items (e.g. figures, tables, charts, or illustrations) which, due to their size and/or shape, must be formatted with the top and bottom of the item along the 11” sides of a page. These pages must be formatted such that, when viewing the page in portrait orientation, the bottom of the item is toward the right margin. The item must also fit within the prescribed margins for a document; in landscape orientation, this means that the top and bottom margins (the long edges) of the page must be 1.25 inches, while the left and right margins (the short edges) of the page must be 1 inch.

The page number for the landscape-oriented page(s) must be in the same location and orientation as page numbers found on all other pages in the document (centered .5” from the bottom of the page in portrait orientation). When viewing the page in landscape orientation, this means that the page number will be centered half an inch from the left edge of the page, and rotated so that the bottom of the page number is toward the left edge of the page.

Only tables/figures should be placed on landscape pages; no paragraphs should be included on a landscape page. For help with landscape-oriented pages, see the “Useful Tips” section at the end of this Guide. You may also find an example of a correctly-formatted landscape page in the Sample dissertation on the Graduate School’s website.

**III. Document Organization**

Your document must be assembled in the order shown here. The sections designated as “required” must be in your final thesis/dissertation. You do not have to include the sections labeled “optional.”

A. Title page – required.
B. Copyright page – recommended.
C. Dedication – optional.
D. Acknowledgements – optional.
E. Abstract – required.
F. Preface – optional.
G. Table of Contents – required.
H. List of Tables – required if there are 4 or more tables.
I. List of Figures – required if there are 4 or more figures.
J. List of Symbols – optional.
K. List of Abbreviations – optional.
L. Foreword or Introduction.
M. Chapters or sections.
N. Bibliography or References or Works Cited pages – required.
O. Appendix or appendices – optional.

The Title page through the List of Abbreviations constitutes the front matter or introductory material of your document. The Foreword/Introduction and chapters/sections make up the main body of your thesis/dissertation. Each of the items in this list has specific formatting instructions, detailed below. See the Graduate School’s website for a sample of a correctly-formatted thesis/dissertation.

A. Title Page

Your thesis/dissertation must have a title page. All the content on the title page is to be centered on the page, both vertically and horizontally. Do not include a page number on the title page, but do include the title page in the pagination sequence of your document. The title page must contain the following information, in the following order:

1. The title of your thesis/dissertation as the first line of text on the page. If your title is more than one line, single-space. The title (and all other details) must be exactly the same on the title page and in the ETD Administrator online submission system.
2. Directly below the title should be a blank line. On the next line, type the word “by” and insert another blank line below.
3. Next, your name should be on a line by itself. Include your name exactly as you have entered it in the ETD Administrator online submission system. For example: if you included your full middle name in the system, then you should also include it on the title page.
4. Insert one or two blank lines, then type the degree(s) you already possess; on the next line, list the granting institution, and the year it was received (single-spaced). For instance:

   Bachelor of Arts
   University of South Carolina, 2007
   Include each bachelor and higher degree you have previously earned (double-space between degrees), listed in chronological order by date received. Do not include the major with the degree(s), and do not abbreviate the degree(s).
5. Next, insert a solid black line. The line distance should be about half the width of the page, centered.
6. The following language should be next (double-spaced):

   Submitted in Partial Fulfillment of the Requirements

   For the Degree of [insert your degree here] in

   [insert your major here]

   [insert the name of your college]

   University of South Carolina

   [year of graduation]
Accepted by:

[your major professor’s/thesis director’s name], [Major Professor OR Director of Thesis]

[committee member’s/reader’s name], [Committee Member OR Reader]

[committee member’s/reader’s name], [Committee Member OR Reader]

[committee member’s/reader’s name], [Committee Member OR Reader]

Cheryl L. Addy, Vice Provost and Dean of the Graduate School

See the Graduate School website’s Programs Offered page for information on your degree/school/major. Use the full name of your degree – for example, “Doctor of Philosophy” not “Ph.D.” Students completing a dissertation will typically have a Major Professor and Committee Members, while students completing a thesis will typically have a Director of Thesis and Readers. If you have two major professors (as indicated on the signature form), designate each as “Major Professor.” Likewise, if you have two directors of your thesis, designate each as “Director of Thesis.” Do not include titles or degrees (such as “Dr.”, “Prof.”, or “Ph.D”) with any name on the title page.

B. Copyright Page

Although you are not required to do so, the Graduate School recommends that you include a copyright notice with your document. According to U.S. law, your work is protected from the moment it is created in a tangible fixed form (including in an electronic form) – you do not have to publish the work, register the work, or pay any fee in order to have copyright protection. Therefore, you may include a copyright notice with your thesis/dissertation even if you have not registered it with the U.S. Copyright Office. However, there are certain benefits to registration. For more information, visit the U.S. Copyright Office online at www.copyright.gov. If you decide to register, you may opt to have UMI file for copyright registration on your behalf (for a fee) during the electronic submission process, or you may personally register with the U.S. Copyright Office.

If you decide to include a copyright page, it must be in the following format:

1. Approximately 2” from the bottom of the page, include the following language:
   © Copyright by [insert your name], [year of graduation]
   All Rights Reserved.
   This two-line statement should be single-spaced and horizontally centered on the page. There should be no text or content on the page besides this statement. When inserting your name, type it exactly as it appears on the title page. This page should be immediately after the title page.

2. The copyright page should contain the lowercase Roman numeral “ii” in the center of the page, .5” from the bottom of the page.

3. If, instead of including an “All Rights Reserved” notice, you would like to release your thesis/dissertation under some less-restrictive type of license, such as a Creative
Commons license, you should indicate as much on this page. The format of this page will remain the same, but the language will differ depending on the license you choose.

C. Dedication
D. Acknowledgements

You are not required to include a dedication or any acknowledgements, but if you decide to include either, each must follow these guidelines:
1. For the dedication page, the heading “Dedication” is to be at the top of the page, followed by a blank line. For the acknowledgements page, use “Acknowledgements” instead.
2. Next, include the body of your dedication/acknowledgements, double-spaced. The body should be no longer than one page, and may be either left- or fully-justified.
3. If you included a copyright page, the dedication page should contain the lower-case Roman numeral “iii” in the center of the page, .5” from the bottom of the page; if you did not include a copyright page, the dedication page should display “ii” instead. The acknowledgements page should follow in the same sequence.

Note: you may not combine these two items into one page – the Dedication and the Acknowledgements are two separate items and must be on separate pages. They are grouped here only because the formatting requirements are identical for both pages.

E. Abstract

Your thesis/dissertation must have an abstract. The following guidelines are required for an abstract section:
1. The word “Abstract” should be at the top of the page as a heading, followed by a blank line. Remember, all pages with headings must have a 2” top margin, while other pages have only a 1” top margin. Thus, if your abstract continues beyond a single page, the first page will have a 2” top margin, while the remaining pages will have a 1” top margin.
2. Next, include the body of your abstract, double-spaced. The body of your abstract may be left- or fully-justified, and should generally be no longer than 350 words.
3. Regarding pagination, the abstract page should follow in the same lowercase Roman numeral sequence as the other front matter. For example, if you included a copyright page, a dedication page, and an acknowledgements page, then “v” should be placed on your abstract page.

F. Preface

A preface is not mandatory, but if you include one, it must be in accordance with these requirements:
1. “Preface” should be at the top of the page, followed by a blank line.
2. Double-space the body of the preface, either left- or fully-justified.
3. The pagination should follow the same lowercase Roman numeral sequence as the previous pages in your document.
G. Table of Contents

A table of contents is required in your document.

1. The heading “Table of Contents” is to be placed at the top of the page, followed by a blank line. The first page of the table of contents should have a 2” top margin. If your table of contents is more than one page, only include the heading on the first page; the remaining pages should have 1” top margins, with no heading.

2. The following items must be listed in your table of contents (if included in your document):
   - Dedication;
   - Acknowledgements;
   - Abstract;
   - Preface;
   - List of tables;
   - List of figures;
   - List of abbreviations;
   - List of symbols;
   - Each chapter, including the chapter number and descriptive title;
   - Bibliography/references;
   - Each appendix, including the appendix letter and descriptive title;
   - Endnotes.

3. Do not include the title page, the copyright page, or the table of contents page(s) in your table of contents.

4. When listing chapter headings and subheadings, do not include more than one level of subdivision within a chapter; you may list chapter titles only, or chapter titles and the next level of headings, but none below that. The descriptive chapter headings and subheadings within the table of contents should match exactly the language used within the body of your thesis/dissertation itself.

5. The title of each entry listed in the table of contents should be justified to the left of the page, along the left margin. However, subheadings below a chapter heading are to be indented.

6. Page numbers in the table of contents should be along the right margin of the page (remember, the side margins are 1.25” throughout the document). Include a leader (a line of dots) in the space between the entry name and the corresponding page number. See page 23 of this guide for information regarding how to format leaders in Microsoft Word. Do not simply insert a line of periods with the page number at the end, because that method will not result in all of the page numbers being properly aligned on the margin.

7. Double-space between each entry. If an entry takes up more than one line, split the entry about three-fourths of the way across the page, and place the remaining text on the next line, single-spaced. Only include a leader from the last line.

8. The table of contents page(s) should include a page number in lowercase Roman numerals, in the same sequence as the rest of the front matter.
H. List of Tables

I. List of Figures

If you have fewer than four tables or figures in your document, you are not required to list them. If you have four or more tables or figures, however, you must include a list of tables or figures, which must be formatted in the following way:

1. The phrase “List of Tables” must be at the top of the page, followed by a blank line. Use “List of Figures” for the list of figures.
2. The number and title of each table/figure should be aligned on the left margin of the page. The descriptive title/caption must be included, not just the number.
3. Page numbers in the list should be right-justified. Include a leader between the title of the table/figure and the corresponding page number. If a title is more than one line, single-space the entry, and only include a leader from the last line of the title.
4. Double-space between each entry.
5. The descriptive titles of tables/figures in the list should match exactly the language used within the body of your thesis/dissertation itself.
6. The page(s) containing the list should include a page number in lowercase Roman numerals, in the same sequence as the rest of the front matter.

Note: the list of tables and list of figures may not be combined into one list; if you include a list of tables and a list of figures, they must be on separate pages.

J. List of Symbols

A list of symbols is not required, but if you choose to include one, follow these guidelines:

1. Type “List of Symbols” at the top of the page, then insert a blank line.
2. All the symbols should be left-justified along the left margin.
3. After typing the symbol, tab over once, then type the definition or description of the symbol. The beginning of each definition/description should be aligned on the page.
4. Double-space between entries. If a definition/description takes up more than one line, single-space for that entry, and make sure that each line of text is consistently left-aligned.
5. Include the page number in the same lowercase Roman numeral sequence as the other front matter.

K. List of Abbreviations

Including a list of abbreviations is optional. The following format must be followed if you decide to include a list of abbreviations:

1. “List of Abbreviations” is to be placed at the top of the page, followed by a blank line.
2. List the abbreviations alphabetically.
3. The abbreviations should be left-justified along the left margin.
4. The definitions of the abbreviations should be right-justified along the right margin. Include a leader between the abbreviation and its definition. In rare instances, a definition may be more than one line; if this occurs, single-space the entry, and right-justify all lines of text.
5. Double-space between entries.
6. Number this page in the same sequence as the other front matter, in lowercase Roman numerals.

L. Foreword or Introduction

M. Chapters or Sections

Your foreword/introduction or Chapter 1 (if you have no foreword/introduction) begins the main body of your document.

1. From this point forward, number all remaining pages (including the bibliography and appendices) in Arabic numerals, starting at “1” on the first page.

2. Every chapter must have a chapter number and descriptive title. When starting a new chapter, include the word “Chapter”, the chapter number, and the title at the top of the first page of that chapter. The first page of each chapter will have a 2” top margin, while remaining pages will have 1” top margins.

3. The text of the main body may be either left-justified (so that only the text along the left side of the page is flush against the margin) or fully-justified (so that the text along both the left and right sides of the page is flush against the margins). Whether you choose left- or full-justification, be consistent in applying your choice throughout your document (this also applies to the following front matter sections: dedication, acknowledgements, abstract, and preface).

4. The first page of each chapter or section of the main body must be listed in the table of contents.

5. Each chapter should begin on a new page. Sub-sections within chapters should not start on a new page unless there is no room on the preceding page (remember to avoid widows and orphans).

N. Bibliography or Works Cited or References pages

A bibliography/works cited/reference list is required at the end of your thesis/dissertation.

1. If your particular discipline or program of study uses a specific form or style manual for bibliographic entries, consult the rules for that form when preparing your bibliography. Whatever style manual you use, be consistent in applying only that style to the format of your bibliography.

2. However, be aware that margins and fonts for your bibliography must be formatted in accordance with the specifications set out earlier in this guide.

3. Likewise, you are required to number your pages in the same style as the rest of your thesis/dissertation – Arabic numerals centered .5” from the bottom of the page, in the same sequence as the main body of your document.

4. Select a heading appropriate to your discipline or style manual (such as Bibliography, Works Cited, References, Sources Consulted, etc.) and place it at the top of the page (use a 2 inch top margin on the first page).

5. Refer to your style manual when determining whether to single-space or double-space bibliographic entries.

6. Even in the bibliography, remember to avoid widows and orphans.
O. Appendix or appendices

Appendices are optional. The purpose of an appendix is to include information that does not have an appropriate place in a chapter. Examples of material suitable for an appendix might be surveys, computer programs, or formulas.

1. Within your document, all appendices are to be included after the reference pages; no appendix should appear directly after a particular chapter, even if that appendix only pertains to that chapter.

2. Each appendix should be given a unique letter designation and a descriptive title, which should be displayed at the top of the first page; for example: “Appendix A: Focus Group Questions.” The first appendix should be “Appendix A”; the second appendix should be “Appendix B”; etc. Each appendix heading is considered a major heading, and should be formatted in the same style as the chapter headings.

3. As with all other pages in your document, appendices must conform to the margin requirements set forth above. The first page of each appendix should have a 2 inch top margin, while subsequent pages have a 1 inch top margin.

4. Every appendix must be listed in the table of contents, and all appendix pages should be numbered using Arabic numerals, continuing in the same sequence as the rest of your document – do not start a new numbering sequence.

IV. Journal Articles as Chapters, or Manuscript Style

Some departments may allow you to include, as chapters, articles that have been or will be submitted to scholarly journals. This style is also referred to as manuscript style, and has been approved by the Graduate School for use by all departments. However, you must have the approval of your department to use the manuscript style for chapters in your document.

The format requirements explained in the preceding sections also apply to manuscript chapters, regardless of how the manuscript was previously formatted for submission to a publisher. You are not required to change the content of your manuscripts that have been published or prepared for publication, but you are required to change the presentation of that content so that it meets the Graduate School’s format requirements. This section of the format guide details the requirements for using manuscript style – these requirements apply only to manuscript chapters, in addition to the requirements described in the previous sections of this format guide.

A. Authorship

You must be either the sole author or the first co-author of each manuscript submitted as a manuscript chapter. It is acceptable to submit a manuscript that you co-authored with others, but you must be the first/primary author.
B. Copyright Release

You must include evidence that you have received permission to use articles which have been published or accepted for publication. It is your responsibility to secure copyright releases prior to submitting your document to the Graduate School. There is no specific form the evidence must take; as long as it is clear that you have permission to re-use the content, that will be sufficient. Common types of permission include a letter or email from the publisher, a screenshot of the publisher’s website explaining your rights as an author, or a printout from the Copyright Clearance Center. Your document will not be accepted as a final submission until all necessary copyright releases have been received by the Graduate School. The evidence of permission should be included within the dissertation itself, not submitted separately. Typically, students have done this by inserting the evidence as an appendix to the document labeled “Permission to Reprint” or some similar title.

C. Overall Document Structure

Your document must include an abstract that is relevant to the dissertation as a whole; it is not sufficient to only include the abstracts from the included articles. A document using manuscript style must also include:

1. An introductory chapter that informs the reader of the structure of the document.
2. A literature review that defines the objectives of the research.
3. A concluding chapter that ties together the major results. Unavoidably, this will duplicate some of the introductory and concluding material in each article.

In this way, the dissertation will be presented as a unified product, rather than simply a collection of related but separate manuscripts.

D. Tables and Figures

Tables and figures in manuscript chapters must be numbered in the same sequence and using the same convention as all other tables and figures in the thesis/dissertation, so that no table/figure number occurs more than once in a document. Do not use the same table/figure numbers that you used in preparation for submission to a publisher.

E. Chapter Cover Page

The names of all authors, in journal-submitted order, and the name of the journal – with volume, page numbers, date (if known), and article status (e.g., “to be submitted,” “submitted to,” etc.) – must be given as a footnote to the title on the first page of each manuscript chapter, so as to indicate the current status of each manuscript. The text of the journal article may begin on either this first page or on the subsequent page. A sample chapter cover page appears on the next page of this guide. Note that there are four footnotes on the page, showing you the language that you need to include based on whether your article has been published, accepted for publication, submitted, or to be submitted. Place an appropriate footnote on your cover page, and follow the citation format delineated by your style manual.
CHAPTER 2

THE TITLE OF YOUR CHAPTER BELONGS HERE, CENTERED
AND DOUBLE-SPACED


1 Sample, I.G. and U.B. Goodwin. Accepted by Psychology Today. Reprinted here with permission of publisher, 12/10/2012.

1 Sample, I.G. and U.B. Goodwin. Submitted to Psychology Today, 12/10/2012.

1 Sample, I.G. and U.B. Goodwin. To be submitted to Psychology Today.
V. Useful Tips

A. Templates

Downloadable templates in MS Word format are available on the Graduate School website. There is a full template that contains all sections in one document, and there are also templates for individual pages or sections. The templates have been pre-formatted, so that all you need to do is enter in your information wherever you find red text in the document (don’t forget to change all the red text to black before submitting). You are not required to use a template, but if you choose to do so, the template should not be your only point of reference when formatting your thesis/dissertation – the templates are designed to be used in conjunction with this formatting guide, not in lieu of it.

Please note that some content or pages in the templates may or may not be in your document. If you decide not to include one or more of the optional sections in your document, then you must remove those pages from the template, and adjust your Table of Contents and page numbers accordingly. Also note that if you use a template, the formatting may be altered as you edit your document. For example, the templates have been divided into multiple sections (see the information regarding section breaks, below); if you are not careful, you may end up deleting the section breaks and throwing off the formatting. Pay attention as you make changes, so that you are careful to keep everything where it needs to be.

One helpful way to keep track of formatting in MS Word is to show the paragraph and formatting indicators that are usually hidden. To do this, navigate to the “Home” tab, and click the paragraph symbol (¶) in the upper right corner of the “Paragraph” section. This is a useful tool because it shows you where invisible things like tabs and section breaks have been inserted.

Finally, do not use the templates or samples when determining which style to apply in your document (such as APA, Chicago, MLA, etc.). As previously mentioned in this Guide, you should refer to the style manual approved by your department as you write your thesis or dissertation. This is especially important for things like in-text citations, footnotes, endnotes, bibliography, etc.

B. Samples

The Graduate School website also contains downloadable samples available as PDF files. Again, the samples should not be the only thing you consult when creating your document – they are provided only as examples of what properly formatted submissions look like. One sample contains red text to indicate information that needs to be changed in your document, and also contains instructions, reminders, and tips in blue text that are designed to help you along. Be aware that your final document must contain only black text; the red and blue text in the sample is only a different color to assist you in the preparation of your final document. A second sample contains no annotations and is indicative of what a final submission will resemble.
C. **Formatting Margins**

To change the margins in MS Word 2010 for Windows (your particular operating system or software version may have slightly different procedures, though the functionality and process will be similar), click the “Page Layout” tab at the top of the window, then click the “Margins” icon in the “Page Setup” section. At the bottom of the list, click “Custom Margins” to bring up a dialog box.

![Custom Margins dialog box](image)

Now, set the margins for the top, bottom, left, and right of the page. Your bottom margins will always be 1”, and your left and right margins will always be 1.25” throughout your document, but your top margins will be either 1” or 2”, depending on whether a given page has a heading (see the section on General Formatting, above, for specific requirements regarding
margins). To format different top headings for pages within a single document, use section breaks (see the next section of this guide, below, if you need assistance creating sections). Once you have adjusted the settings, click “OK” to apply your selections and save your changes.

D. Page Breaks and Section Breaks

When you need to start a new page, do not repeatedly press “Enter” until you get to a new page. Instead, insert a page break. This method is preferable because no matter the changes that you make above the page break, the text after the page break will always appear on a new page. To do this in MS Word, make sure that your cursor is at the location in your document where you want to insert the page break, then navigate to the “Insert” tab at the top of the window, and click “Page Break;” alternatively, hold the “Ctrl” key on your keyboard and press “Enter.”
A section break divides the document into sections, each of which can have unique formatting settings. To insert a section break in MS Word, navigate to the “Page Layout” tab at the top of the window, click “Breaks” (found in the “Page Setup” group), and select the appropriate type of section break you want to insert under the “Section Breaks” heading.
To adjust the settings of a section, make sure the cursor is in the section you want to alter, then click the arrow in the bottom right corner of the “Page Setup” section under the “Page Layout” tab. At the bottom of the dialog box that appears, you can choose to apply the settings to only that particular section, to the entire document, or to everything following the section break.
E. Formatting Leaders

When you need to insert a leader (a line of dots) in your document, follow these procedures. First, position your cursor in the location where you want the leader to be. Then, go to the “Home” tab at the top of the window and click the arrow in the lower right corner of the “Paragraph” section. Click the “Tabs…” button at the bottom of the dialog box that appears. This will bring up a new dialog box.

![Dialog Box for Setting Tabs]

Clear any tab stops that have already been entered by clicking the “Clear All” button. At the top of the dialog box, enter a new tab stop position of 6”. Since your left and right margins must be set at 1.25”, a 6” tab stop will ensure that your tab will align on the right margin. Under “Alignment,” select “Right,” and under “Leader,” select the second option (a line of dots). Next, make sure you click “Set” before clicking “OK.” Now, when you insert a tab at that position in your document, it will automatically align on the right margin and include a leader from the
location you enter the tab. You may also format multiple tabs using this interface; to do so, simply type another length in the “Tab stop position” field. For instance, if you wanted the first tab on a line to be .5” and the second to be 6”, you would first type “.5” in the field, then click “Set,” then type “6” and click “Set” again. Don’t forget to adjust the “Alignment” and “Leader” options for each tab stop.

F. Landscape Orientation

If you have a large table or figure in your document, it may be necessary to orient one or more of your pages in landscape format, meaning the longer sides of the page (11”) are on the top and bottom, and the shorter sides (8.5”) are on the left and right. Rather than keeping the page in portrait orientation and rotating the content (so that the reader will be forced to turn his/her head in order to read the information), you should use the tools in the word processor to rotate the page such that the content is readable from left to right on a computer screen.

To do this in MS Word 2010, first click at the end of the page before you want to begin landscape orientation. Insert a “Next Page” section break (see the instructions elsewhere in this guide if you need to learn how to insert section breaks). Your cursor should now be on a new page; go ahead and create another “Next Page” section break so that the entire page is blank. Now make sure your cursor is in the section you want to change to landscape orientation. On the “Page Layout” tab at the top of the page, click “Orientation” in the “Page Setup” group, and select “Landscape.” The page should now be in landscape orientation.
With your cursor placed anywhere on the first page of the section with landscape pages, go to the “Insert” tab, navigate to the “Header & Footer” group, and click “Header” to bring up a list of options; click “Edit Header” near the bottom.
You will be taken to a “Header & Footer Tools” tab. In the “Navigation” group, make sure that “Link to Previous” is not highlighted. Click “Go to Footer” and make sure that “Link to Previous” is also not highlighted there before clicking “Close Header and Footer.” Next, place your cursor in the first page that is in portrait orientation following the landscape page(s), and repeat the process of un-linking to previous sections – make sure that both the header and footer do not have “Link to Previous” highlighted. You may now edit the page number of the landscape oriented page(s) without altering the page numbers of other sections.

The page number on your landscape oriented page(s) is probably still at the bottom of the page (which should now be the 11” side). You must change the page number so that it is in the same position as all the other pages. To do this, first delete the page number on the landscape page(s). Then, go to the “Insert” tab, navigate to the “Header & Footer” group, and click “Page Number.” In the drop-down list that you see, choose “Page Margins,” and click “Large, left” under the “Plain Number” heading. Use your mouse to highlight the page number that appears in the box, go to the “Home” tab, and change the font type and size to match the rest of your document.
Now you will need to rotate the page number so that it is in the proper direction. In the “Drawing Tools” format tab at the top of the window, go to the “Text” group and click “Text Direction.” Rotate the text 90 degrees such that the bottom of the page number is toward the left side of the page. Now, the content is readable on a computer screen, and the page numbers are consistent for all pages.
G. Embedding Fonts

ProQuest/UMI requires that all fonts be embedded in your document before you upload it to their site. Embedding fonts ensures that the content of your document will be viewable on all computers. To embed fonts in MS Word 2010, first click the “File” tab in the top left of the window, then click “Options.” In the new dialog box that appears, click “Save” on the left side. At the bottom of the window, make sure there is a check in the box beside “Embed fonts in the file,” and that there is not a check in the box beside “Do not embed common system fonts.”

H. Assembling Your Final PDF

The final document that you submit must be in a single PDF file, but there are several ways you could create that file. The first is to create a single MS Word file, ensure that all formatting requirements have been met, and then convert that file to PDF. You may either convert the MS Word file to PDF yourself prior to submission, or you may use the conversion tool on the ProQuest/UMI site to convert your MS Word file to PDF.

However, if you are having trouble with the formatting features of MS Word, it is also possible to create multiple files (one for the title page, one for the table of contents, one for the main body, etc.), convert each one to PDF, then combine them all into a single PDF using Acrobat Pro or some other PDF editing software. If you decide to use this method, you may want to use the individual templates for each section (such as title page, abstract, table of contents, etc.) provided by the Graduate School. Keep in mind the fact that this method will require you to keep track of multiple files and make sure that you have put them all in the correct order before you submit.

VI. Submission

A. How to Submit your Thesis/Dissertation to the Graduate School

After you have verified that the format of your thesis/dissertation conforms to the requirements set out in this guide, you will be ready to submit. As mentioned previously, no paper submissions will be accepted; the submission process is completely electronic through ProQuest/UMI’s ETD Administrator system. You may only use the ETD Administrator system to submit – do not email your file or transmit it to the Graduate School via other means. All submissions – even for the format check – must be submitted through the ETD Administrator.

To submit your thesis/dissertation, visit the Graduate School’s Thesis and Dissertation page (http://gradschool.sc.edu/students/thesisdiss.asp) and click the “Submit Your Document” link, which will take you to the ETD Administrator system. When you visit that page for the first time, you will have to create a new account; this account is not connected to any account you already have for USC, and is only for the purpose of submitting your thesis/dissertation.
After creating your account, you will be prompted to input all of the information about your thesis/dissertation, and upload your document as a PDF. It is important to note that all of the information you include in the system (such as title, your name, abstract, committee members’ names, etc.) must be exactly the same as the corresponding information in your PDF. Finally, you must click the “Submit” button in order to submit your thesis/dissertation and initiate the review process. The initial version you upload will not be considered the final version, and you will have the opportunity to make changes to the document (up until the final submission deadline).

When you click submit, the Graduate School staff will be notified automatically, and your document will be reviewed for format compliance. You will then be contacted regarding any changes that must be made to the format. The email address that you used to create your ETD Administrator account will be the method used to contact you, so be sure to check that inbox for correspondence regarding your submission (don’t forget to check the spam/junk folders, just in case). It may take several days until you hear back from a staff member. If there are revisions required, you should make them in your word processor and create a new PDF. You will then need to visit the ETD Administrator site once again, but this time you will just log in to your existing account in order to submit your new version – DO NOT create a new account. You will use the same account for the entire submission and review process – there is not a separate process for format check and final submission.

Once you have submitted the final version of your thesis/dissertation in a satisfactory format, it will be accepted as the final submission. At that point, there is no other step that you need to take in order to submit a final version. The latest version that you uploaded and that has been accepted will become the final version after graduation.

B. Deadlines

There are two deadlines you will need to meet: format check deadline and final submission deadline. You may verify the deadlines for format check and final submission by viewing the calendar on the Graduate School website. On or before the format check deadline, you must initially submit for the format check. The content of your thesis/dissertation does not have to be finalized by this deadline, but you must make a good faith effort to submit a document that adheres to the format requirements. You will have the opportunity to make changes to the document after the format check deadline, but not after the final submission deadline. You are encouraged to submit early for the format check, if possible, so that you will have more time to make any changes that may be necessary before the final submission deadline. On or before the final submission deadline, you must submit the final, committee-approved document that conforms to all of the Graduate School’s format requirements. Both of these deadlines are mandatory – if you miss either of these deadlines, you will not be eligible to graduate until the following semester, at the earliest.